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1 About this User Manual 

1.1 The Purpose of this Manual 

• Audience: This User Manual is intended for designers using the Traffic Sign Computer Aided 

Design (TraSiCAD) software program for the design of signs. 

• Scope:  The User Manual describes the process involved to: 

− create new signs within standard guidelines 

− produce designs for manufacture, and 

− interpret messages, warnings, and errors. 

• Reader skills: The User Manual assumes that the reader has a basic knowledge of 

− personal computers 

− Australian Standard AS 1743 Road Signs – Specifications, and 

• Expected outcomes: After studying this User Manual, the reader should be able to 

− create new signs 

− understand sign clearances, and 

− print drawings. 

2 Using TraSiCAD 

2.1 What is TraSiCAD? 

TraSiCAD is a program developed by the Department of Transport and Main Roads to assist in the 

design of road signs. 

This User Manual is intended to be used in conjunction with: 

• Australian Standard AS 1743 Road Signs – Specifications 

• Australian Standard AS 1744 Standard Alphabets for Road Signs, and 

• the Queensland Manual of Uniform Traffic Control Devices (MUTCD). 

More information can be found at the department's website. 

2.2 Installing TraSiCAD 

Go to the department's TraSiCAD webpage. 

• Find Install_TraSiCAD_v2.930.zip file. 

• Save to a relevant folder on your local drive and unzip it. 

• Run Install_TraSiCAD_v2.930.msi. 

TraSiCAD will automatically set up all files. 

Follow all prompts until completed, then select Finish. 

https://www.tmr.qld.gov.au/business-industry/Road-systems-and-engineering/Software/TraSiCAD
https://www.tmr.qld.gov.au/business-industry/Road-systems-and-engineering/Software/TraSiCAD
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2.3 Opening TraSiCAD 

After installation has been completed, open the program by either: 

1. running from the executable file in the directory in which the program was installed, or 

2. double-click on the TraSiCAD icon developed on the computer desktop during the installation. 

The TraSiCAD working screen, as shown in Figure 2.3, will appear. 

Figure 2.3 – TraSiCAD working screen 

Note: TraSiCAD has its own complete Help function that may be used in conjunction with this User Manual. 

2.4 Setting up defaults and options 

TraSiCAD can set various default options required during the drawing design process. Before using 

TraSiCAD, the various options can be set up with default characteristics. 

For faster and more efficient use of the program, these options should be set prior to the 

commencement of any design. 

2.4.1 Options  

From the Tools directory, select Options. 

This opens a dialogue box with four tab functions: General, Edit, New sign and Display. 

2.4.1.1 General 

Figure 2.4.1.1 shown the General screen. 

Figure 2.4.1.1 – Options screen 
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The General tab: 

• gives the option of selecting parameters with particular RTA characteristics 

• accesses the clearance rule set* that determines the particular clearance rules for the 

elements within the sign 

• sets the order in which clearances are made 

• allows automatic setting of borders and corner radii when clearance rules are applied, if 

required, and 

• redirects the default sign saving directory to user defined, if required. 

* These rule sets are based on AS 1743 and should not be modified unless there are valid design reasons. It is 

essential that the appropriate rule set is selected for correct clearances. There are two options available: 

• AS 1743 Dark_on_Light (for dark legend on light background) 

• AS 1743 Light_on_Dark (for light legend on dark background). 

2.4.1.2 Edit 

Figure 2.4.1.2 shows the Edit screen. 

Figure 2.4.1.2 – Edit screen 

The Edit tab: 

• varies the nudge distance of elements on the sign face 

• achieves fine control of element placement by using the UP / DOWN / LEFT / RIGHT arrows 

on the keyboard 

• allows selection of copying file types 

• selects the number of Undo functions available, and 

• can decide if the Undo / Redo stack is reset or not after a Save function has been completed. 
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2.4.1.3 New sign 

Figure 2.4.1.3(a) shows the New sign: Default legend screen. 

Figure 2.4.1.3(a) – New sign: Default legend 

The Default legend option: 

• sets the Default legend height which sets clearances consistent with the rule set being used 

• enables the setting of default legends for the various signs and route markers used with the 

various wizards, and 

• should be completed prior to using TraSiCAD. 

Figure 2.4.1.3(b) shows the New sign: Default print settings screen. 

Figure 2.4.1.3(b) – New sign: Default print settings screen 

The Default print settings option: 

• selects the ability to show arrow heads in dimensions 

• selects the default printing scales 

• sets the default print margins, and 

• sets the default font for the print title block. 
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Figure 2.4.1.3(c) shows the New sign: Default title block settings screen. 

Figure 2.4.1.3(c) – New sign: Default title block settings screen 

The Default title block settings option: 

• sets default Business Unit Details, and 

• loads / deletes a pre-designed logo as a default for use in the print title block. 

2.4.1.4 Display 

Figure 2.4.1.4 shows the Display screen. 

Figure 2.4.1.4 – Display screen 

The options on this screen set the colouring characteristics of TraSiCAD when non-system colours are 

displayed and represented. 

When using a display device with a colour palette smaller than 24 bits, some colours will not be 

available in the device palette and will need to be approximated. Two methods are available: 

• closest match – colours are represented by the closest matching colour from the logical 

palette of the display device, and 

• dithering – colours are represented by drawing a pattern using similar colours. 
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2.5 Starting a drawing 

There are four different methods of accessing drawings within the TraSiCAD program, as shown in 

Figure 2.5. 

Figure 2.5 – Accessing drawings from the File directory 

Selecting the File directory indicates New, Open, Use Wizard or the file history bar. 

Note: Once a drawing has been commenced, it is recommended that the Sign Properties Feature (Alt+P) is used 

to enter user-nominated variables (see Section 2.7.4). 

2.5.1 New 

Figure 2.5.1 shows the screens that appear when New is selected. 

Figure 2.5.1 – New screen options 

These options are used to develop new signs, using basic styles and backgrounds. There are up to 

16 different styles that are selectable from this box. 
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2.5.2 Open 

Figure 2.5.2(a) shows the screen that appears when Open is selected. 

Figure 2.5.2(a) – Open screen option: Opening a previously designed sign 

This option is used to open a previously designed sign from a file directory. This option can be used to 

modify, copy, or print previously designed signs selected from the user’s specific local or network files 

and directories (see Section 2.4.1.1). 

Alternately, the Open option can be used to access the specific Signs directory within TraSiCAD, as 

shown in Figure 2.5.2(b). 

Figure 2.5.2(b) – Open screen option: Accessing the Signs directory 

This directory contains a number of signs, as shown in Figure 2.5.2(c). 

Figure 2.5.2(c) – Examples of signs available in TraSiCAD Signs directory. 

After clearance with AS 1743 Light_on_Dark ruleset, borders and external and internal corners are reset. 

2.5.3 Use Wizard 

Table 2.5.3 details the steps and shows the screens that appear when the Use Wizard option is 

selected. This option is used to select a particular type of sign from a list of wizards (Roads and 

Maritime Services (RMS) selection if needed, see Section 2.5.1). This gives a specific design of a sign 

which will be set out according to predetermined standard format and style. 
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Table 2.5.3 – Wizard selection process 

Wizard step Screen illustration 

Select required Wizard 
(depending on the 
installation used (RMS or 
Transport and Main Roads), 
an example window indicates 
the type of sign to be 
selected)   

RMS selection Transport and Main Roads 
selection 

Select number of panels (if 
available), the particular 
legend type and height. 

Note: The legend value selected 

only assigns the characteristics 

for the legends on that sign and 

has no bearing on the Default 

legend height value that set the 

clearance values between the 

elements on that sign.  

 

For each of the panels 
requested in the previous 
step, select, and apply 
details for a Road Name 
Patch, Route Marker type 
and number, Arrow type and 
Legend. 

Note: To assist with drawing 

efficiency, the subsequent use of 

any wizard allows the user to 

use previously entered values of 

a wizard when it was last run; for 

example, if a three-panelled 

wizard design was initially used 

and there was a requirement for 

a subsequent two-panel sign, 

any of the legends or symbols 

from the first two panels may be 

selected for use in that new 

design. 
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2.5.4 History bar 

Figure 2.5.4 shows the screens that appear when the History bar option is selected. 

Figure 2.5.4 – History bar 

This option is used to select up to 10 previously designed drawings without needing to close a current 

drawing. 

2.6 Drawing options 

2.6.1 Functions 

Drawing options are available in the Edit menu, as shown in Figure 2.6.1. Modifications, additions, 

and adjustments can be made to any sign drawing. 

Figure 2.6.1 – Drawing options in Edit menu 
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The functions dialogue box gives access to options which include: 

• Undo 

• Redo 

• Add 

• Align 

• Adjust 

• Copy 

• Cut 

• Paste 

• Paste Special, and 

• Delete. 

Selection from this list in the Edit directory or using the associated shortcut keys will use the functions 

as follows. 

2.6.1.1 Undo 

The Undo function undoes the last number of drawing steps carried out (Undo levels are set in the 

Tools directory under Options / Edit – see Section 2.4.1.2). 

2.6.1.2 Redo 

The Redo function redoes the previous Undo function. Redo levels are limited by the amount of Undo 

levels. 

2.6.1.3 Add 

The Add function facilitates the addition of various items to be inserted in a drawing, as shown in 

Figure 2.6.1.3. 

Figure 2.6.1.3 – Add options to insert in a drawing 
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Items are: 

• Legend 

• Road Name Patch 

• Route Marker 

• Other Sub-Sign 

• Image From File (see Section 2.6.6) 

• Arrow Symbol (see Section 2.6.7) 

• Roundabout Symbol (see Section 2.6.8), and 

• Diagrammatic Direction Symbol (see Section 2.6.9). 

2.6.1.4 Align 

The Align function allows for the horizontal or vertical alignment of two or more separate items on a 

drawing. 

Note: All preselected items will be aligned to the last item selected in the Align process, which is detailed in 

Table 2.6.1.4. 

Table 2.6.1.4 – Align process 

Step Screen illustration 

Alignment of two single items 

Select the first item to be aligned to another. 

 

Hold down the Shift key and select the 
second item. 

Select Edit directory, then Align (or Ctrl L). 
An Alignment Tool dialogue box will appear. 

Select the relevant Horizontally (Top, 
Centre, or Bottom) or Vertically (Left, 
Centre or Right) alignment box. 

The items will appear aligned on the screen. 

Select OK. 

The sign will be permanently aligned and 
updated in the drawing. 

Vertical alignment of multiple legends (for example, Rest Area and 1km) 

Quantity items may be made up of 
two separate 'words' (for example, '1' and 
'km'). To correctly align these separated 
quantity items with other legends, select the 
number '1' 

 Hold the Shift key then select 'km'. 

While still holding the Shift key, select the 
legend 'Rest Area' to which the quantity item 
is to be aligned. 
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Step Screen illustration 

Select Edit directory, then Align (Ctrl L) 
where an Alignment Tool dialogue box will 
appear. 

 

Select the Group Into Rows box. This will 
group select the '1' and the 'km.' This will be 
indicated on the screen with dotted box 
enclosing both items selected. 

 

 

Select Centre for a centre alignment. A 
position measurement indicator will appear 
signifying the centre position of the new 
alignment line. Manual modifications to this 
position measurement can be made in this 
box if required by direct editing or using the 
up / down arrows. 

 

Select OK to generate the newly aligned sign. 

 

2.6.1.5 Adjust 

The Adjust function sets the automatic adjustment of items on the sign face at predetermined 

clearances. Two separate options are available: Apply Clearance Rules and Reduce Sign. 

The Apply Clearance Rules option is shown at Figure 2.6.1.5(a). 
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Figure 2.6.1.5(a) – Adjust: Apply Clearance Rules option 

The Apply Clearance Rules option enforces an automatic clearance on all items on the drawing to 

give predetermined spacing from rules installed within TraSiCAD. These rules can be found in the 

Rule Editor in the Options directory (see Section 2.4.1.1). 

Note: Clearances are determined by the 'Default legend' size and not the size of the legend being used on the 

drawing. 

The Reduce Sign option is shown at Figure 2.6.1.5(b). 

Figure 2.6.1.5(b) – Adjust: Reduce Sign option 

The Reduce Sign option completely reduces the sign to its smallest size, taking into consideration 

and applying clearance rules formulated in the rule sets previously mentioned in Section 2.4.1.1. 

It will set the borders and corner radii to the appropriate values if the particular requested boxes are 

checked in the Options / General dialogue box (see Section 2.4.1.1). 

2.6.1.6 Copy 

The Copy function takes a copy of the selected item on the drawing and places it on a working 

clipboard to be reused on that drawing or in other compatible software applications. The copied item 

remains intact on the drawing. 

2.6.1.7 Cut 

The Cut function takes a copy of the selected item before erasing it from the drawing. It places it on a 

working clipboard to be reused on that drawing or in other compatible software applications. This 

function can also be used as a Delete. 

Note: The working clipboard will only hold one item at a time. If another object is subsequently cut or copied, the 

previous object will be overwritten, depending on the number of Undo levels. 

2.6.1.8 Paste 

The Paste function places the object obtained by the last Cut or Copy function from the working 

clipboard onto the present working drawing. 
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2.6.1.9 Paste Special 

The Paste Special function enables two separate ways to import items from the clipboard of other 

Windows applications. 

• Paste Text as a Legend: Takes text copied or cut to the clipboard from other compatible 

applications and places it on the working drawing in a text editable format. 

• Paste Metafile as Image: Imports an object or text copied or cut to the clipboard from other 

compatible applications and places it on the working drawing in a non-editable form. This is 

ideal for quickly importing logos and symbols from electronic brochures. 

2.6.1.10 Delete 

The Delete function deletes any object from the drawing. This option does not use the working 

clipboard; therefore, the object will be deleted permanently. The Undo function will undelete any 

object deleted, depending on the amount of Undo levels set in the Options / Edit box (see 

Section 2.4.1.2) 

2.6.2 Adding a Legend 

Note: The Add function can be activated in shortcut mode by placing the cursor somewhere on the active drawing 

and right-clicking the mouse. A dialogue box with four options, including Add, as shown in Figure 2.6.2(a), will 

appear on the drawing. 

Figure 2.6.2(a) – Add shortcut 

Selecting Legend, as shown in Figure 2.6.2(b), allows specified words to be imported into the drawing 

from the ensuing Add to Panel dialogue box. Particular Legend types and heights can be selected as 

required. 

Figure 2.6.2(b) – Legend option: Add to Panel 
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Note that all fonts used in TraSiCAD are derived from any font in the C:\Windows\Fonts directory. All Australian 

Standard fonts, as shown in Figure 2.6.2(c) (sold separately to the TraSiCAD software), should be installed in that 

directory. 

Figure 2.6.2(c) – Australian Standard fonts 

2.6.3 Adding a Road Name Patch 

Note: The Add function can be activated in shortcut mode by placing the cursor somewhere on the active drawing 

and right-clicking the mouse. A dialogue box with four options, including Add, as previously shown in 

Figure 2.6.2(a), will appear on the drawing. 

Selecting Road Name Patch, as shown in Figure 2.6.3, allows one of the following specified shaped 

patches to be imported into the drawing from the ensuing Add to Panel dialogue box.  

Figure 2.6.3 – Road Name Patch option: Add to Panel 

Sign shape options are: 

• Not Pointed 

• Left Pointed 

• Right Pointed, or 

• Double Pointed. 

Note: The Legend Height used in a Road Name Patch is automatically reduced to 75% of the main sign Legend 

Height. 
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2.6.4 Adding a Route Marker 

Note: The Add function can be activated in shortcut mode by placing the cursor somewhere on the active drawing 

and right-clicking the mouse. A dialogue box with four options, including Add, as previously shown in 

Figure 2.6.2(a), will appear on the drawing. 

Selecting Route Marker, as shown in Figure 2.6.4, allows one of six different types of markers to be 

imported into the drawing from the ensuing Add to Panel dialogue box. 

Figure 2.6.4 – Route Marker option: Add to Panel 

Route marker options are: 

• Alpha-Numeric Route Marker 

• Tourist Route Marker 

• State Route Marker 

• Metroad Route Marker 

• National Highway Route Marker, or 

• National Route Marker. 

2.6.5 Adding Other Sub-Sign 

Note: The Add function can be activated in shortcut mode by placing the cursor somewhere on the active drawing 

and right-clicking the mouse. A dialogue box with four options, including Add, as previously shown in 

Figure 2.6.2(a), will appear on the drawing. 

Selecting Other Sub-sign from the Add to Panel box, as shown in Figure 2.6.5, allows a selection of 

signs to be imported from the ensuing New Sign dialogue box to be placed into the main sign. 

Multiple-sub-signs may be selected. A number of sub-sign panel options are available for selection 

from the New Sign dialogue box. 

Figure 2.6.5 – Other Sub-Sign option: Add to Panel 
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2.6.6 Adding an Image 

Note: The Add function can be activated in shortcut mode by placing the cursor somewhere on the active drawing 

and right-clicking the mouse. A dialogue box with four options, including Add, as previously shown in 

Figure 2.6.2(a), will appear on the drawing. 

Selecting Image From File from the Add to Panel box, as shown in Figure 2.6.6, allows specialised 

image files to be imported into the drawing from the ensuing Open browse dialogue box. 

Figure 2.6.6 – Image From File option: Add to Panel 

TraSiCAD accesses internal directories of .wmf or .emf symbol files to be directly imported onto the 

sign face. Selecting Add: Image From File will usually directly access the Symbols library within the 

TraSiCAD program. In a typical installation this file location will be 

C:\ProgramData\TraSiCAD\Symbols. 

Note: TraSiCAD allows import of any .emf or .wmf files. If other self-generated symbols files are designed, they 

may be placed in this directory for convenience or located in other dedicated directory locations. 

The process to Add: Image From File is shown in Table 2.6.6. 

Table 2.6.6 – Add: Image From File 

Step Screen illustration 

Select the required symbol. 

 

Select Open. 

An Add Image dialogue box will appear, 
indicating the symbol selected. The height and 
width are shown, along with a scaling option to 
increase or reduce the importing size to suit the 
sign dimension requirements. 

 

Options to OK, Change (revert to the previous 
dialogue box for alternative selection) or Cancel 
the symbol are available. 
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2.6.7 Adding an Arrow Symbol 

Note. The Add function can be activated in shortcut mode by placing the cursor somewhere on the active drawing 

and right-clicking the mouse. A dialogue box with four options, including Add, as previously shown in 

Figure 2.6.2(a), will appear on the drawing. 

Various types and sizes of arrows can be added to a panel by selecting Arrow Symbol in the Add to 

Panel X of Main Sign box and the ensuing Add New Arrow Symbol dialogue box, as shown in 

Figure 2.6.7(a). 

Figure 2.6.7(a) – Arrow Symbol option: Add to Panel 

Variations to the types and sizes of arrows can be established and modified through the Add New 

Arrow Symbol dialogue box. 

Select appropriate boxes to alter arrow properties. Settings are based on a particular legend height 

with variations made to: 

• Width 

• Length 

• Shaft length 

• Base width 

• Head height 

• Indent 

• Corner Radius 

• Legend Height and 

• Rotation angle. 
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Other functions to determine colours, rounded or pointed arrowheads and standardised long or short 

length shafts can be made in this option. A zoom function is also available to enhance the details in 

the design box. This function does not affect the zoom in the actual drawing. 

Note: Double clicking on any colour brings up a full colour palette as shown in Figure 2.6.7(b). 

Figure 2.6.7(b) – Full colour palette 

 

2.6.8 Adding a Roundabout Symbol 

Note: The Add function can be activated in shortcut mode by placing the cursor somewhere on the active drawing 

and right-clicking the mouse. A dialogue box with four options, including Add, as previously shown in 

Figure 2.6.2(a), will appear on the drawing. 

Various types and sizes of roundabouts can be added to a panel by selecting Roundabout Symbol in 

the Add to Panel X of Main Sign box and the ensuing Add New Roundabout dialogue box, as 

shown in Figure 2.6.8(a). 

Figure 2.6.8(a) – Roundabout Symbol option: Add to Panel 

Various types and sizes of roundabouts can be designed in the Add New Roundabout dialogue box. 

Three sections can be accessed through various boxes in each, where a number of options for 

specific designs can be entered, as detailed in Table 2.6.8. 
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Table 2.6.8 – Options for specific designs 

Dialogue box 

section 

Design option 

View Zoom  Sets the screen view for optimum design detail 

Roundabout 
colour 

Sets the symbol colour. Double-clicking displays full colour 
palette 

r1 Inner roundabout radius 

r2 Inner roundabout radius 

a Varies height of the triangular tip for selected arc gap styles 

c Width of roundabout and legs 

g Location in degrees of the arc gap 

h Width of the arc gap in degrees 

Arc Gap 
Style 

Sets as Square, Pointed or Double Pointed entry / exit 

Legend 
Height 

Sets the overall size of the symbol 

Rotation 
Angle 

Sets the rotation angle of entire roundabout symbol (in 
degrees) 

Exit Legs Set the Exit Legs to be straight or curved. By checking the Curved box, the 
following options become available: 

Curved left When selected, the Exit's Curve installs for clockwise-driven 
roundabout as opposed to an anticlockwise-driven 
roundabout when unselected 

Attached at 
Base 

Determines if the arc of a curved leg should be tangential to 
the roundabout body or tangential to centreline of the 
triangular tip of that leg 

Exit Leg properties are also available. 

Leg Length Determines the radial distance in millimetres, from the 
roundabout outer edge to the base of the Exit Leg’s 
triangular tip 

New Exit 
Leg 

Inserts extra Legs and indicates them in the associated list 
box 

Selection of a particular Leg in the list box enables the user to: 

• modify parts of Exit Legs 

• Delete or Add a selected Leg, or 

• automatically size an Exit Leg via the Automatic Dimensioning 
Leg option 

If the Automatic Dimensioning Leg box is not checked when an Exit Leg 
is selected, the Leg can be 'manually' sized via the Leg Details box as 
shown in Figure 2.6.8(b). This separate dialogue box individually tailors the 
characteristics of that particular Exit Leg. 
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Dialogue box 

section 

Design option 

Figure 2.6.8(b) – Manual sizing via Leg Details 

 

Entry Leg Entry Legs may be straight or curved. By checking the Curved box, 
two options are made available. 

Curved left Sets the exits to curve clockwise as opposed to the 
default anticlockwise 

Attached at 
Base 

Determines the arc of a curved Leg to be tangential to the 
roundabout body or tangential to centreline of the 
triangular tip of that Leg 

Leg Length modification can also be achieved in this section. 
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2.6.9 Adding a Diagrammatic Direction Symbol 

Note: The Add function can be activated in shortcut mode by placing the cursor somewhere on the active drawing 

and right-clicking the mouse. A dialogue box with four options, including Add, as previously shown in 

Figure 2.6.2(a), will appear on the drawing. 

Various types and sizes of direction symbols can be added to a sign by selecting the Diagrammatic 

Direction Symbol from the Add to Panel dialogue box, as shown in Figure 2.6.9(a). 

Figure 2.6.9(a) – Diagrammatic Direction Symbol option: Add to Panel 

Various types and sizes of diagrammatic direction symbols can be designed in the created Add New 

Diagrammatic Direction Symbol dialogue box, shown in Figure 2.6.9(b). 

Figure 2.6.9(b) – Add New Diagrammatic Direction Symbol option 

When using diagrammatic direction symbols, three process areas are used to assist the design: 

• View section – actively views the design 

• Base Branch Segments – selects and modifies curved or straight segments that, when 

added together, make up a particular branch, and 

• Branches – adds, selects, and modifies branches to make up the basic design. 
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These process areas are detailed in Table 2.6.9. 

Table 2.6.9 – Diagrammatic direction symbols process areas 

Dialogue box 

section 

Design options 

View Zoom Assists in design view. Has no effect on the size of the 
diagram in the drawing. 

Rotation Angle Rotates the diagrammatical as required. 

Legend Height Determines the size of the diagram on the panel. 

Symbol Colour Sets the symbol colour. 

Note: Double clicking on any colour brings up a full colour 

palette as shown in Figure 2.6.7(b). 

Branches The default opening branch is tagged Segment S1 as shown in 
Figure 2.6.9(b). This is, in fact, a pointed segment. As subsequent segments 
are added (straight or curved), they are nominated a sequential number in the 
Base Branch Segments box. 

Base Branch 
Segments 

The newest segment is allocated the Segment S1 notation (the notation for 
each existing segment increases as another new segment is added) as shown 
in Figure 2.6.9(c). 

Figure 2.6.9(c) – Base Branch Segments 

 

Curve Left option allows a default right curve to be changed to left if required.  

Note: Subsequent left curve segments require Curve Left selection each time. 

Selecting a particular segment in the Base Branch Segments box activates 
modifiers: Heading, Length, Width, Radius and Sweep to be altered as 
required. 

Add or remove segments by selecting the Add Line Segment, Add Curve 
Segment or Delete Segment options. 

Once a main Base Branch has been designed in the Base Branch Segments 
box it may be necessary to overlay another branch on that design. 

Selecting the Add Branch button produces another branch which is 
superimposed on the preceding base branch. This is signified by Branch 1 in 
the Branches box. The Base Branch Segments box now changes 
designation to Branch 1 Segments box, indicating another S1 segment relating 
to the new Branch 1, as shown in Figure 2.6.9(d). 



User manual 

Traffic Sign Computer Aided Design (TraSiCAD V2.9.3), Transport and Main Roads, December 2021 24 

Dialogue box 

section 

Design options 

Base Branch 
Segments 
(continued) 

Figure 2.6.9(d) – Add Branch option 

 

This S1 segment and possibly successive segments, although shown in the 
box, exist on top of the base branch and may appear invisible. Only when 
subsequent segments are added will they show their existence, as shown in 
Figure 2.6.9(e). 

Figure 2.6.9(e) – Depiction of multiple segments 

 

When an added branch is selected, the Edit Branch area reveals two further 
options, as shown in Figure 2.6.9(f). 

Figure 2.6.9(f) – Edit Branch option 
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Dialogue box 

section 

Design options 

Base Branch 
Segments 
(continued) 

Heading Sets the direction in degrees to which a segment points. 

Off Set  Sets the amount of offset (distance) the segment is set vertically 
on the branch from the base of the diagrammatical. 

As many new branches as required can be added to make up a detailed 
represented drawing. 

2.6.10 Provision for alphanumeric routes 

In the design of new direction signs, provision should not only be made to accommodate the shield, 

space should be available on the signboard to allow subsequent change to an alphanumeric code by 

overlaying the existing shield. Provision should be made for one letter and up to three digits: for 

example, A369. See Figures 2.6.10(a) to 2.6.10(c). 

Figure 2.6.10(a) – Example of directional sign with insufficient space for overlay 

Figure 2.6.10(b) – Example of directional sign with sufficient space for overlay 
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Figure 2.6.10(c) – Example of overlayed sign 

2.7 Viewing options 

During the drawing process, TraSiCAD uses various viewing options to assist accurate sign detail and 

design. 

There are four options, as shown in Figure 2.7, which can be found in the View directory: 

• Zoom 

• Gridlines Setup 

• Dimensions, and 

• Sign Properties. 

Figure 2.7 – View directory options 

2.7.1 Zoom 

The Zoom feature, shown in Figure 2.7.1, scales the drawing up or down on the screen to assist the 

detailed designing of a sign. 
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Figure 2.7.1 – Zoom option 

Zoom levels range from 50% to 1000%. A Custom zoom range is also available and can be used to 

suit individualised viewing needs. 

2.7.2 Gridlines Setup 

The Gridlines Setup, shown at Figure 2.7.2, enables a series of gridlines to be added to the drawing. 

This assists the particular spacing of items as each item is placed on the drawing. 

Figure 2.7.2 – Gridlines Setup option 

Any nominated grid size intervals up to a maximum of 1000 millimetres may be used. 

2.7.2.1 Show Grid  

When selected, the Show Grid option enables the previously set grid to be visible on the screen for 

the drawing process, as shown in Figure 2.7.2.1. 
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Figure 2.7.2.1 – Show Grid option 

2.7.2.2 Snap to Grid 

When selected, the Snap to Grid option enables the items to be placed and 'snapped' onto the 

drawing along the previously determined grid pattern, as shown in Figure 2.7.2.2. 'Snapping' will occur 

even if the grid is not visible. 

Figure 2.7.2.2 – Snap to Grid option 

2.7.3 Dimension 

Selecting the Dimension feature gives exact indications of the lengths, heights and clearances of 

legends, symbols, and images on a drawing. See Section 2.9.2.1 for details on removing arrow heads 

for clearer detail. 

As shown in Figure 2.7.3, in this mode, there are two separate areas on the screen drawing, showing: 

a) all horizontal and vertical dimensions associated with any items on that drawing, and 

b) a tabled view of all font legends, font types and sizes being used on all the panels and 

sub-signs within that drawing. 
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Figure 2.7.3 – Dimension option 

Note: These dimensions actively vary as any drawing changes are being made. 

2.7.4 Sign Properties  

The Sign Properties option enables the user to navigate and modify colours, panels, plates, legends, 

and elements associated within the sign design. Figure 2.7.4 shows an example of the Sign 

Properties option. 

Note. The Properties box can be activated with Alt+P or by placing the cursor anywhere on the active drawing 

and right-clicking the mouse. A dialogue box with four options appears, as shown in Figure 2.7.4. Select Sign 

Properties. 

Figure 2.7.4 – Sign Properties option example 

This Properties box shows five separate tabs giving access to particular variables within the sign: 

• Panels 

• Legends 

• Signs & Sub-Signs 

• Images, and 

• Guide Symbols. 
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2.7.4.1 Panels tab 

As shown in Figure 2.7.4.1, selecting the Panels tab enables: 

• accurate positioning of items within the sign 

• sizing to particular dimensions 

• splitting panels horizontally or vertically 

• colour panels from the inherent panel colour (determined in Sign & Sub-signs tab) or from a 

colour palette 

• setting inherent border colours (checked), and 

• individually setting and colouring of all borders if a panel is split (unchecked). Refer 

Section 2.7.4.6 for details. 
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Figure 2.7.4.1 – Panels tab 

2.7.4.2 Legend tab 

As shown in Figure 2.7.4.2, selecting the Legend tab once a panel has been selected enables the 

legend type to be: 

• accurately positioned within the panel 

• viewed 

• modified by height and type 

• deleted 

• specifically sized to a height 

• automatically word width calculated, and 

• coloured from a standard nine-colour palette. 
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Figure 2.7.4.2 – Legend tab 

2.7.4.3 Images tab 

As shown at Figure 2.7.4.3, the Images tab allows the selected image on a particular panel to be:  

• accurately positioned within the panel 

• identified 

• sized to desired height or width 

• stretched (non-proportionally) when checked, and 

• deleted. 

Figure 2.7.4.3 – Images tab 
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2.7.4.4 Guide Symbol tab 

As shown in Figure 2.7.4.4, selection of the Guide Symbol tab enables the guide symbol widths and 

heights to be viewed, and: 

• accurately positioned within the panel 

• rotated 

• identified and/or renamed 

• sized according to legend height 

• coloured from a standard nine-colour palette 

• modified via the Symbol Details, and 

• deleted. 

Figure 2.7.4.4 – Guide Symbol tab 

Note: Guide symbol colour options can be increased to full colour palette by selecting Symbol Details 

as shown in Figure 2.7.4.4 and double-clicking on any colour in the Arrow Colour box. 

2.7.4.5 Signs & Sub-signs tab 

As shown in Figure 2.7.4.5(a), selection of the Signs & Sub-signs tab gives an overview of all the 

panels contained within the entire sign. Modifications to panel sizes, position of legends and panels 

within the main sign are available from this tab. 
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Figure 2.7.4.5(a) – Signs & Sub-signs tab 

Selecting the main sign or any sub-sign in the list box will indicate all features associated with the 

makeup of those signs. This will allow control over panel positions, colours, and dimensions as well as 

border widths and colours. It also indicates the default legend types and height of each panel. 

Note: The default legend height is used to calculate ALL clearances on a sign, irrespective of what other legend 

sizes are being used on the sign. See Section 2.4.1.3. 

Selecting a sub-sign, road name patch or route marker will: 

• display an Auto Resize Route Markers and Road Name Patches check box – when this box 

is checked (as shown in Figure 2.7.4.5(b)), changing the size of legend on the 'active sign' (if it 

is a route marker or road name sign / patch) will change that active sign’s width and height 

proportionally; if it is not checked, the size of the legend will not automatically be scaled with 

the sign's resizing 

Figure 2.7.4.5(b) – Auto Resize Route Markers and Road Name Patches check box 
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• highlight the active sign / patch and, subsequently, access control of panel / patch positions, 

dimensions, border sizes and colours 

• indicate the default legend types and heights 

• enable panel legend modification 

• delete a sub sign, and 

• enable options to Publish Legend and Print Details of any sub-panel or patch when a 

drawing is printed. 

Note: If Publish Legend is left unchecked, only legends for the main panel are printed. If Print Details is left 

unchecked, no subsequent sub-panels or their details are printed. 

2.7.4.6 Multi-panel selection and inner border radius control 

As shown in Figure 2.7.4.6(a), when a multi-panel sign is selected from New, the external corners, the 

panel corners and the borders require clearance rules to be applied. Default setting is only applied at 

this stage. 

Figure 2.7.4.6(a) – New multi-panel sign 

As shown in Figure 2.7.4.6(b), when clearance is applied, borders, external corners and panel corners 

are set according to the rule set used. 

Figure 2.7.4.6(b) – Clearance applied to new multi-panel sign 

Note: Any panel colour can be changed independently with no effect on the internal corners of that panel, as 

shown in Figure 2.7.4.6(c). 
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Figure 2.7.4.6(c) – Example of independent panel colour change 

However, when Inherit colour from parent sign is deselected, as shown in Figure 2.7.4.6(d), the 

internal corner radii of that panel are transformed to straight corners. 

Figure 2.7.4.6(d) – Deselection of Inherit colour from parent sign 

It is, therefore, not possible to achieve internal panel corners when a different coloured border is 

required in that separate panel, as shown in Figure 2.7.4.6(e). 

Figure 2.7.4.6(e) – Different coloured border in separate panel 
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2.7.4.7 Multi-panel border and colour control 

When a multi-panel sign is selected, there are options to: 

• by checking the appropriate boxes, inherit all panel colours, border widths and colours from 

the main (or parent) sign panel as shown in Figure 2.7.4.7(a) 

Figure 2.7.4.7(a) – Inherit panel colours, border widths and colours 

or 

• unchecking the appropriate boxes, independently changes the panel colours and border 

widths and colours as compared to of the main (or parent) sign panel as shown in 

Figure 2.7.4.7(b). 

Figure 2.7.4.7(b) – Independent change of panel colours and border widths and colours 

Note: Internal corner radii are removed. 
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Figure 2.7.4.7(c) provides an example of external border colour control. 

Figure 2.7.4.7(c) – Example of external border colour control 

Note: The internal borders are a combination of two halves. Allocation of an internal width and its colour must be 

complemented with that of an adjacent panel border. 

2.8 Saving a drawing 

The saving of a drawing will be necessary at some stage in the process to have it archived for future 

reference and use. 

TraSiCAD has three alternatives of saving a drawing. Saving is initiated from the File directory to gain 

access to one of three options: Save As, Save and Export. 
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2.8.1 Save As 

Selecting Save As as shown in Figure 2.8.1(a) saves a new drawing into a default TraSiCAD \ Signs 

directory (see Section 2.4.1.1). A user-defined file name is requested at this point and a .sgn 

extension will be assigned. 

Figure 2.8.1(a) – Save As selection 

If an alternate location is required, select the required drive (for example, C drive) and directory (for 

example, Signage Design) then name the file and select the Save button as shown in Figure 2.8.1(b). 

Figure 2.8.1(b) – Save As alternate selection 

2.8.2 Save 

Once a drawing has been initially saved or opened from a file, the Save function, shown in 

Figure 2.8.2, updates and saves any modifications performed on the working drawing to that point. All 

updates are saved in that same file name and directory. 
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Figure 2.8.2 – Save selection 

2.8.3 Export 

The Export feature enables the exporting of a drawing in a non-editable bitmap (*.BMP) and 

Jpeg (*.JPG) or as an editable Metafile (*.EMF) format, as shown in Figure 2.8.3. These formatted 

files may then be imported into other compatible software programs. 

Figure 2.8.3 – Export selection 

 



User manual 

Traffic Sign Computer Aided Design (TraSiCAD V2.9.3), Transport and Main Roads, December 2021 41 

2.9 Printing 

TraSiCAD has four options to customise drawing printouts found in the File directory: Printer Setup, 

Page Setup, Print Preview and Print. 

2.9.1 Printer Setup 

The Printer Setup selection, as shown in Figure 2.9.1, produces a dialogue box that enables the 

printer properties to be modified on a selected networked or local printer. 

Figure 2.9.1 – Printer Setup selection 

2.9.2 Page Setup 

The Page Setup selection, as shown in Figure 2.9.2, produces a dialogue box with Layout, Title 

Block and Margins tabs. 

Figure 2.9.2 – Page Setup selection 
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2.9.2.1 Layout tab 

The Page Setup>Layout tab selection, as shown in Figure 2.9.2.1, determines various options. 

Figure 2.9.2.1 – Page Setup>Layout tab 

Options in Layout are: 

• Show Dimension Arrows: Toggles arrowheads on drawing for clearer viewing and printing. 

• Drawing Size: Sets a scale of either Fit to Page or Custom to determine the print size of the 

drawing on the page. 

• Print Patch Detail: Enables all patch details to be viewed and printed separately. 

• Print Symbol Detail: Sets a requirement for any symbol details on the drawing to be shown 

superimposed on a grid pattern, in the Print Preview or when printed out as an attachment to 

the sign drawing. When checked, a Symbols per Page box appears. This sets the number of 

symbols required to be set out on each additional page. As the number increases, the grid 

pattern size will change to suit. 

• Printer Setup: Produces a Printer Setup dialogue box that enables the printer properties to 

be modified on a selected networked or local printer. 

2.9.2.2 Title Block tab 

The Page Setup>Title Block selection, as shown in Figure 2.9.2.2(a), gives access to areas that, 

when filled out, will be installed automatically in the title block of the drawing. 

Figure 2.9.2.2(a) – Page Setup>Title Block selection 

 



User manual 

Traffic Sign Computer Aided Design (TraSiCAD V2.9.3), Transport and Main Roads, December 2021 43 

Options in Title Block are: 

• Title Block Font: Sets the font that will be used throughout the entire title block. 

• Title Block Details: Business Unit details are recalled from Defaults options (see 

Section 2.4.1.3). Details can be modified if required. 

• Logo: Logo details are recalled from Defaults options (see Section 2.4.1.3). Logos can be 

replaced. using the Load, Delete and Load Defaults functions. 

• Sign No.: The saved drawing record title. 

• Date Last Modified: Time and the date drawing last saved. 

• Designed: Usually the person completing the drawing. 

• Checked: Usually an office supervisor. 

• Specifications: Materials listed here are inserted within Specifications in the Title Block 

area. 

• Add Materials: As shown in Figure 2.9.2.2(b), when selected, this option brings up a common 

list of materials that can be quickly selected and added to the Specifications area within the 

drawing title box. This materials list can be modified in any text file editor tool (for example, 

Notepad). The materials list file (materials_list.ini) can be found in the TraSiCAD directory (for 

default installations, C:\Program Files(x86)\TMR\TraSiCAD). 

Figure 2.9.2.2(b) – Add Materials option 

• Additional Information: Information listed here is inserted into the title block within the 

drawing area and below the sign. 
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2.9.2.3 Margins tab 

The Page Setup>Margins selection, as shown in Figure 2.9.2.3, allows the setup of the drawing 

margins with independent sizing of all boundaries or installation of set defaults (see Section 2.4.1.3). 

Figure 2.9.2.3 – Page Setup>Margins selection 

Options available in the Margins selection are: 

• Display Unprintable Region: Displays the actual printable area (in blue colour) along with 

unprintable region measurements, and 

• Printer Setup. 

2.9.3 Print Preview 

The Print Preview option, as shown in Figure 2.9.3, enables the designer to preview the active 

drawing to view its details as a printed output. This dialogue box gives five options to aid Print 

Preview, plus a Help function for on-screen assistance. 

Figure 2.9.3 – Print Preview selection 
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The options available by selecting Print Preview are: 

• Previous 

• Next 

• Print 

• Setup, and 

• Close. 

2.9.3.1 Previous 

The Print Preview>Previous option allows scrolling backwards to view previous pages where the 

drawing contains arrows, roundabouts, diagrammaticals, route markers or road name patches (the 

Print Symbol Details or Road Patch Details boxes are to be checked in the Layout tab of Page 

Setup. See Section 2.9.2.1). 

Note: The Print Details box in Sign Properties also has to be selected if a sub-sign (road name patch or route 

marker) is to be printed. 

2.9.3.2 Next 

The Print Preview>Next option acts as a forward scrolling button to access other pages in the 

drawing, as shown in Figure 2.9.3.2. 

Figure 2.9.3.2 – Print Preview>Next option 
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2.9.3.3 Print 

The Print Preview>Print option starts the printing process through a print box where print settings 

can be checked and modified. 

Note: Where available to the user, prints can be made to Adobe PDF files as well as printers 

2.9.3.4 Setup 

The Print Preview>Setup option reverts to the Page Setup box. See Section 2.9.2.1. 

2.9.3.5 Close 

The Print Preview>Close option closes the print preview and reverts to the screen view of the 

drawing. 

2.9.4 Print 

The Print option, as shown in Figure 2.9.4, starts the printing process through a print dialogue box. At 

this point, print settings can be checked and modified before committing to the nominated Adobe PDF 

or hard copy print. 

Figure 2.9.4 – Print selection 

2.9.5 Sign Object Viewer 

Figure 2.9.5 – Sign Object Viewer selection 

The options available in Sign Object Viewer are: 

• Create List 

• Save As Text, and 

• Print List. 
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2.9.5.1 Create List 

The Create List option found in Sign Object Viewer as part of Tools \ Options. As shown in 

Figure 2.9.5.1, Create List allows screen viewing of a created list of parts associated with the active 

sign design. Details of every element on that sign can be viewed in this list. 

Figure 2.9.5.1 – Sign Object Viewer>Create List option 

2.9.5.2 Save as Text 

The Sign Object Viewer>Save as Text option allows the Object list to be saved as a text file for 

exporting to other documents. 

2.9.5.3 Print List 

The Sign Object Viewer>Print List option prints out a copy of the Object list directly from TraSiCAD 

to the nominated printer. 

2.10 Closing a drawing 

On completion of the drawing. select File, Close as shown in Figure 2.10. When a dialogue box 

appears to confirm your decision: 

• select Yes for the drawing to be either: 

− saved in the current working file (if the drawing has already been nominated a file 

name previously), or 

− a file directory dialogue box will appear, allowing selection of an appropriate file name 

in a preferred directory, or 

• select No for the drawing to be closed without saving last changes. 
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Figure 2.10 – Close selection 
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3 Licensing 

Warning! TraSiCAD is protected by a registered software protection locking system. Any attempt to 

bypass this lock licensing software will result in the permanent closing down of the TraSiCAD 

program. 

3.1 Licensing details 

All licensing details and options to extend or transfer the licence of the TraSiCAD program can be 

found in the Tools, Licence directory as shown in Figure 3.1(a). 

Figure 3.1(a) – Licensing details 

Selection of the Licence option will initiate a Register TraSiCAD dialogue box, indicating the number 

of days left until the licence expires, as shown in Figure 3.1(b). For the initial evaluation installation, 

the number of registered days will be 1–30 days. The fully licensed version range will be 1–365 days. 

TraSiCAD indicates it is fully licensed when the Register tab indicates only an Application window 

and shows the Licence expires in [number of] days exceeding 0. 

Figure 3.1(b) – Register TraSiCAD selection 
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Note: After expiry of the licence, TraSiCAD will show a dialogue box message indicating TraSiCAD has not been 

registered and will run in demonstration mode, as shown in Figure 3.1(c). In that mode, no wizard or printing 

functions will be available. The serial number will be required when requesting a new or extended licence Unlock 

code. 

Figure 3.1(c) – Unlock TraSiCAD 

Application for the purchase or extension of a TraSiCAD program licence must be preceded by 

payment of the appropriate fees. Payment and enquiries should be directed to: 

Email: TrafficEngineering.Support@tmr.qld.gov.au. 

3.2 Extension of licence 

On submission of a registration form (including the serial number of the TraSiCAD program) and 

payment of appropriate licensing fees, an unlock code will be issued to the user. This code may be 

used by following the process shown in Table 3.2. 

Table 3.2 – Unlock Code process 

Process step Screen illustration 

Select Tools, Licence 

 

If the program is already licensed or still in the 
evaluation period, the serial number will be 
found in the Extend tab. 

 

mailto:TrafficEngineering.Support@tmr.qld.gov.au
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Process step Screen illustration 

If the licence has expired, the serial number will 
be found on the Register tab or the Unlock tab 

 

With the serial number displayed, enter the 
supplied unlock code, provided by the supplier, 
into the Enter Unlock Code box. 

 

The licence expiry date will be upgraded 
showing Licence expires in … days 

 

3.3 Transfer of licence 

If necessary, a TraSiCAD program may be transferred to another personal computer (PC). 

Note: Only the balance of the unused time of the licence is transferred and the host PC then becomes unlicensed. 

Any transfer will require the destination PC to have an evaluation copy of the TraSiCAD program installed (see 

sections 2.1 and 2.2). 

The process to transfer a TraSiCAD program is provided in Table 3.3. 
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Table 3.3 – Transferring TraSiCAD process 

Process step Screen illustration 

Go to the destination PC (where the program is 
to be transferred to and an evaluation copy has 
been installed). Select Tools, Licence. 

 

Select the Extend tab and record the serial 
number of that installed program. 

 

Return to the licensed PC (from which the 
program is to be removed). Select Tools, 
Licence, Transfer tab. Enter the previously 
recorded serial number (from the 
destination PC) in the Enter Serial Number of 
Destination Program box. 

 

Click the Transfer button, A dialogue box will 
appear to confirm your intention to transfer. 

 

A new dialogue box will appear on your 
confirmation, displaying an eight-digit, 
alphanumeric unlock code. Record the code. 

 

Return to the destination PC and enter the recorded unlock code into the Register or Extension 
tab as appropriate. Refer to sections 3.1 and 3.2 for instructions on these. 

Note: Ensure entry is in capital letters and that the alphanumeric sequence is entered correctly (beware of the 

number '5' and letter 'S', the number '1' and letter 'I', the number '0' and letter 'O'). 

3.4 Frequently asked questions 

Some frequently asked questions relating to installing and using TraSiCAD are provided in Table 3.4. 

Table 3.4 – Frequently asked questions 

Question Instruction 

Where can I find my serial 
number? 

Go to Tools>Licence>Extend. 

How can I register my copy of 
TraSiCAD? 

See Section 3.1 Licensing Details. 
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Question Instruction 

How can I extend my licence? Before your yearly licence is about to expire, you need to apply 
for an extension by sending an email to 
TrafficEngineering.Support@tmr.qld.gov.au to receive advice 
about the necessary action. 

I received the unlock code to 
extend my licence. How do I 
proceed to extend it? 

Go to Tools>Licence>Extend and enter the unlock code in the 
Enter Unlock Code field. 

How do I transfer my licence? See Section 3.3 Transfer of Licence. 

I want to register my licence, 
but I don’t see the serial 
number? 

Uninstall and install TraSiCAD again or ask an Administrator to do 
that if you do not have administrative rights. 

I registered my licence but 
TraSiCAD still runs in demo 
mode? 

An Administrator should uninstall and install TraSiCAD and run 
the newly-installed TraSiCAD software first. The program will 
generate a serial number which should be emailed to 
TrafficEngineering.Support@tmr.qld.gov.au to receive an unlock 
code. 

After receiving the unlock code, the Administrator should register 
the software, exit the program, and log off. The user then should 
log in with their user account and run TraSiCAD. 

For further information or matters relating to TraSiCAD not covered in these frequently asked 

questions or this User Manual, please email TrafficEngineering.Support@tmr.qld.gov.au. 

 

mailto:TrafficEngineering.Support@tmr.qld.gov.au
mailto:TrafficEngineering.Support@tmr.qld.gov.au
mailto:TrafficEngineering.Support@tmr.qld.gov.au
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